GUIDELINES
FOR
COMPLETING
THE
MASTER OF LAWS THESIS

(updated Summer 2014)
COMPLETING THE MASTER OF LAWS THESIS

This document is intended to provide to GW Law students guidelines on matters relating to the Master of Laws (LL.M.) thesis. The Law School’s Bulletin identifies the thesis requirements for LL.M. candidates. The standards set out in the Bulletin govern to the extent that the matters below are inconsistent with the Bulletin.

General Thesis Guidelines

Full-time LL.M. students (those enrolled for 9 or more credit hours/semester) are expected to complete all degree requirements within one calendar year of matriculation. Part-time LL.M. students (those enrolled for 8 or fewer credit hours/semester) are expected to complete all degree requirements within two calendar years of matriculation.

The thesis must be a substantial scholarly work of a quality and length akin to a law review article. The thesis is to be written under the supervision of a full-time member of the Law School faculty or, with the approval of the program director, an adjunct member of the Law School faculty. The thesis adviser assigns the thesis grade and is the final authority with regard to thesis deadlines. When a faculty member accepts a student’s request to serve as thesis adviser, the two parties should establish and agree, in writing, to a timeline of thesis deadlines based on the student’s planned graduation date.

The thesis adviser may provide, at his/her discretion, written consent to an extension of the thesis deadlines up to one calendar year. The thesis adviser, in consultation with the program director, also has discretion in establishing a minimum page length requirement for the thesis. The student must fulfill the page minimum established by the thesis adviser or the thesis will not be accepted for grading. The thesis adviser may impose additional requirements regarding the thesis subject, outline, content, citation style, authoritative support, and general presentation. Furthermore, the thesis adviser must approve the student’s research methodology, and must receive at least one preliminary draft of the thesis. Individual thesis advisers may require additional drafts and/or outlines for review.

1 Students should check the Law School academic calendar for the exact date of spring graduation. Summer graduation is always August 31. Fall/winter graduation is always January 31.
Thesis Course

Students writing an LL.M. thesis must enroll in Thesis (Law 690 and Law 691), a four credit scholarly writing class taught by a member of the Law School’s Legal Writing faculty. Full-time LL.M. students should register for Thesis during the fall and spring semesters of their degree program. With the permission of the thesis adviser and notice to the program director, a full-time LL.M. student planning to graduate in August may take Law 691 in the summer semester. Part-time LL.M. students may enroll during the summer semester or during the fall or spring semesters of the second year of their degree program.

Thesis 690, which meets four times during the semester in small group classes, provides structure and guidance in selecting a thesis adviser and topic; researching and forming a thesis statement; organizing and outlining; and initiating the drafting process. Thesis 691 meets four times during the semester and covers early drafting, polishing, and tips for seeking publication. The course includes work in progress meetings during which students engage in peer review. Thesis 691 is a restricted course; therefore the student must seek written approval from his or her thesis adviser before registering for the course in person in the Records Office. Both Thesis 690 and Thesis 691 are offered every semester (fall, spring, and summer).

In general, the student is expected to satisfy all requirements established by both the instructor for Law 690/691 and by the student’s thesis adviser; submission of the material to one does not alone satisfy any requirements for submission of material to the other.

The Writing Center

Enrolled students are encouraged to make use of the Writing Center, during or after taking the Thesis courses, for constructive feedback on portions of a working draft up to 15 pages.

To learn about the Law School Writing Center offerings and make an appointment, visit: http://www.law.gwu.edu/Academics/EL/Writing%20Center/Pages/WritingCenterOverview.aspx

The Writing Center webpage also includes helpful links to numerous online writing centers offering self-help materials on grammar, style and usage: http://www.law.gwu.edu/Academics/EL/Writing%20Center/Pages/WritingResources.aspx

Students are also eligible to make appointments with the main University Writing Center, which is staffed by writing instructors, who can be particularly helpful for non-native speakers of English: http://www.gwu.edu/~gwriter/

2 The “Permission to Register for a Restricted Course” form is available in hard copy in the Records Office.
Completing Degree Requirements

The student bears the responsibility to maintain contact with and provide regular progress updates to the thesis adviser. The student’s work in Thesis 690 will show as credits “in progress” until the thesis is accepted and graded. If the student fails to complete the thesis by the established deadline and while enrolled in Law 691, however, the student must secure an approved extension in writing from the thesis adviser.

With the written approval of the thesis adviser, a student may receive an extension of up to one calendar year to complete the thesis. During this year or portion thereof, the student must maintain continuous enrollment; breaking enrollment during this time will require readmission into the Law School. A student who, due to extraordinary circumstances, requires time beyond the aforementioned one-year extension to complete the thesis must seek written approval from the thesis adviser and the program director before the one-year extension expires. Thesis advisers may establish supplemental requirements regarding additional time requests.

Once an extension for completion of the thesis has been approved, the student must contact the Records Office to arrange for continuous enrollment for the next semester. A student who fails to maintain continuous enrollment will be required to apply for readmission in order to continue in the degree program. Currently the charge for continuous enrollment is $35.00; this fee enables continued use of the Burns Law Library and Lexis/Westlaw passwords. Provision of Westlaw and Lexis access is handled by the Library's Electronic Services Department and all requests for passwords or password extensions/reactivation must be sent to eservices@law.gwu.edu for verification of enrollment status before passwords are extended or reactivated. Emails should state the student's name, whether they are enrolled as a student or as continuous enrollment for thesis completion, the semester[s] of enrollment, and the GWID number. Because continuous enrollment is a semester by semester determination, the student must email Electronic Services to request an extension EACH semester.

An application for graduation must be submitted for each semester in which graduation is anticipated. The Records Office will not renew prior applications. The deadline for submitting an application for May graduation is February 1. A pdf version of the graduation application is available at:
http://www.law.gwu.edu/Students/Pages/Forms.aspx

---

3 The LL.M. Graduation Application may be faxed to the Records Office at 202.994.8980. Questions regarding graduation should be directed to the Records Office at 202.994.6261.
Submission of the Thesis to the Electronic Theses/Dissertations System (ETDS)

The George Washington University Electronic Thesis/Dissertation initiative is an effort to help LL.M. students create works of scholarship that are interactive, visually appealing, and readily accessible to a large audience of interested readers. All completed theses must be electronically submitted to the ETDS at http://www.etdadmin.com after the thesis adviser has assigned a grade. Students on continuous enrollment as of fall 2009 are exempt from the requirement to submit the thesis electronically.

Specific instructions for how to submit the thesis to ETDS are provided in the Thesis 691 course materials and outlined in the attachments below. Formatting requirements, to which the student must carefully adhere in order for his or her thesis to be accepted for grading by the thesis adviser and subsequently submitted to ETDS, are provided on pages 7 and 8 of this document. Three attachments include sample formatting, as well as step-by-step instructions for uploading the thesis to ETDS. Attachment 4 is the ETD Approval form, which must be completed and signed by both the thesis adviser and student before the thesis can be approved for submission to ETDS. Attachment 5 is the reimbursement form to be submitted via email to kthornton@law.gwu.edu, with a credit card receipt from ETDS, to seek reimbursement from the law school for the ETDS processing fee.

The Portable Document File (PDF) submitted on-line to ETDS must be final and error-free. The ETDS Administrator will not edit the thesis. Students must wait until the thesis adviser has approved the final draft before submitting the PDF file to ETDS. Any suggestions or revisions made by the thesis adviser must be incorporated into the thesis before ETDS submission.

Publishing the Thesis in a Law Journal

As the author of a thesis, the student will own the copyright to his or her work. By submitting the thesis to ETDS, the student grants a license to The George Washington University. The student may wish to “embargo” his or her thesis, making the thesis unavailable for viewing on ETDS for up to two years, while the student secures a contract to publish an article or book based on the thesis. For additional information on ETDS and publication of theses, the student should visit: http://www.gwu.edu/~etds/publisherissues.html.

The Law School must be given credit for material used in the publication of any portion or adaptation of a student’s thesis. This credit typically appears on the Disclaimer or Acknowledgements page (see samples in Attachment 1); e.g., “This Article was submitted to partially satisfy the requirements of a Master of Laws degree at The George Washington University Law School.”

Students receive additional guidance on the process of seeking journal publication in the Thesis 691 course.
Academic Integrity

In writing the thesis, all students must act in full accordance with the GW Law School Policy on Academic Integrity. Specific provisions of note include, §§ 4.1 (the pledge of honesty), 5.2 (academic dishonesty), and 8.2 (sanctions). Students are also expected to be familiar with the Law School’s handbook, Citing Responsibly: A Guide to Avoiding Plagiarism. These documents can be found by clicking the “Integrity Code” and “Citing Responsibly” links at http://www.law.gwu.edu/Academics/Pages/Academic_Integrity.aspx.

If you have any questions concerning the thesis guidelines, please contact your thesis adviser or Prof. Karen Thornton, Upper Level Writing Program Coordinator (202.994.4651).
THESIS SUBMISSION REQUIREMENTS FOR LL.M. DEGREE CANDIDATES

Candidates must follow all of the formatting requirements outlined below. Failure to comply with these requirements will result in rejection of the thesis by the Electronic Theses/Dissertations System (ETDS) and may delay graduation. Thesis advisers may set additional guidelines to supplement, but not replace, these minimum requirements. Supplemental formatting guidelines can be found on the specific LL.M. program websites.

Formatting

• Preliminary pages must be in the following order (see Attachment 1 for specific layout)
  • Title Page (required)
  • Dedication (optional)
  • Acknowledgements (required)
  • Disclaimer (optional)
  • Abstract (required)
  • Table of Contents (required)
  • List of Figures (required if there are figures)
  • List of Tables (required if there are tables)
• Word-formatted
• Times New Roman (12 pt.)
• Double-spaced text
• 1.5 inches left margins
• 1 inch margins on the top, bottom, and right
• Footnotes with proper Bluebook citations (no endnotes)
• No blank pages
• Page numbering:
  • Lower case Roman numerals for preliminary pages [e.g. title page, table of contents (see attachment 1 for sample formatting)]
    ▪ Title page is page i, but is not numbered
    ▪ Page numbers are to be located at the bottom center
  • Arabic numerals beginning with “1” on the first page of text and continue to the end
    ▪ Page numbers are to be located at the bottom center
    ▪ All pages, including appendices or supporting documents, must be numbered
  • See Attachment 2 for a guide to adjusting page numbering.
Additional Formatting Requirements for Submission to the ETDS

- The document must be submitted to ETDS as a single PDF file.
- There must be no password protection on the PDF and security settings must allow for printing.
- Fonts must be embedded in the Word document before conversion to PDF.
- The following tools will convert documents to PDF:
  - PDF Conversion Tool in UMI ETD Administrator (RTF and Microsoft Word documents only)
  - Adobe also offers an online service for PDF file creation: https://createpdf.adobe.com/
- For a tutorial and FAQs on creating PDF files for submission to ETD, visit http://www.etdadmin.com/cgi-bin/main/createpdf.
ATTACHMENTS

1) Sample Formatting of Preliminary Pages

2) Page Numbering Guide for MS Word

3) Ten Step Process for Uploading the Thesis to ETDS

4) ETD Approval Form

5) Reimbursement Form
Attachment 1

Sample Formatting of Preliminary Pages
The Title of the Thesis
By
Brilliant Law Student {full name - no initials}
B.A., June 1985, Impressive University
J.D., May 1990, Impressive Law School
{List bachelors and all graduate degrees with
dates conferred and names of conferring institutions}

A Thesis submitted to

The Faculty of
The George Washington University Law School
in partial satisfaction of the requirements
for the degree of Master of Laws
May 18, 2014
{or the convocation date on which your degree will be conferred}

Thesis directed by
Your adviser’s name  {exactly as it appears in the Law School Bulletin}
{The adviser’s title, exactly as it appears in the Law School Bulletin}
Acknowledgements

The author wishes to thank…. 
Disclaimer

Captain ________ serves in the U.S. Air Force Judge Advocate General’s Corps. This paper was submitted in partial satisfaction of the requirements for the degree of Master of Laws in Government Procurement at The George Washington University Law School. The views expressed in this paper are solely those of the author and do not reflect the official policy or position of the United States Air Force, Department of Defense or U.S. Government.
Abstract


Over the past nine years.....
I. Introduction ......................................................................................................................... 1
II. Background ......................................................................................................................... 4
Introduction

[text]
Attachment 2
Page Numbering Guide for MS Word
Page Numbering Guide for MS Word
(with gratitude to Dan Schwender, LLM ’11)

1. Create your title page.

2. At the end of your title, go to the “Page Layout” tab, select “Breaks” and choose “Next Page” to create a section break.

3. On the new page, create your table of contents. At the end of your table of contents, go to the “Page Layout” tab, select “Breaks” and choose “Next Page” to create a section break.

4. On the new page, write the text for your article.

5. Now, return to your table of content page. Double click the footer area on your table of content page. It should read “First Page Footer Section 2” and a new “Design” tab should appear at the top of your screen.

6. Choose the “Page Number” section within the “Design” tab and select the appropriate positioning of your numbers (i.e. bottom/center). If you are using Word 2011 and encounter a problem inserting page numbers directly into the footer, close the footer and simply use the insert page number drop down menu.

7. Choose the “Page Number” section again and select “format numbering” and select the appropriate number style (i.e. lower-case roman numerals “i, ii, iii…”).

8. Now return to the first page of your article’s text. Double click the footer area on your first text page. It should read “First Page Footer Section 3” and a new “Design” tab will appear on the top of your screen.

9. Choose the “Page Number” section and select the appropriate positioning of your numbers (i.e. bottom/center).

10. Choose the “Page Number” section again and select “format numbering” and select the appropriate number style (i.e. standard numerals “1, 2, 3…”).

11. Your pages should now be correctly numbered. If you used the Multilevel list (outline formatting) under the “Home” tab “Paragraph” section while writing your paper, then you can right click the table of contents and update it automatically. Otherwise, you will have to create a table of contents manually.

***Additional Word formatting guides for Mac and PC are provided in Thesis 691.
Attachment 3
Ten Step Process for Uploading the Thesis to ETDS
Ten Step Process for Submitting the Thesis to ETDS

1) Start by visiting www.gwu.edu/~etds.
   a) In the left hand navigation bar on that page you will find a link to the Law School’s Guidelines for Completing the Master of Laws Thesis, under School-specific Guidelines. These guidelines include specific requirements for font, margins, and page numbering, as well as a sample of the preliminary pages of the final thesis document.
   b) In the same left hand navigation bar you can also sign up for Microsoft Word Training at your desktop if you feel you need a refresher for purposes of formatting your thesis in accordance with the law school’s guidelines before you upload it onto ETDS.
   c) Further down this left hand navigation bar you will find a link to Frequently Asked Questions (FAQ) about submitting via ETDS, as well as specific information about Copyright Issues.
   d) You must download the “ETD Approval Form,” which can be found on the left hand navigation bar under Submitting Your ETD. This form must be signed by your thesis advisor after he/she has graded your thesis and then submitted to Prof. Thornton (kthornton@law.gwu.edu) before she can give final approval to your thesis via ETDS. The ETD Approval Form is also available at Attachment 4 of this Guide.

2) The next step is to create an account at www.etdadmin.com. The first time you visit the site, you’ll go to the sign in at “Student” in the upper right hand corner and click “Submit.” In the future, you will login via “Student,” “Revise my dissertation/thesis” in the middle of the page and use a username and password. You can come back to the www.etdadmin.com site as often as you need to complete the uploading process and make revisions. When asked to identify your institution, click on “The George Washington University.”

3) The first page will present Publishing Options with a set of instructions. You must select “Open Access Publishing.” The law school will reimburse you for the cost of Open Access Publishing. You may decide whether you want an “embargo” on your paper to withhold posting on the internet for up to two years. You may also decide whether you want major search engines like

---

4 The reimbursement form is Attachment 5 to this Guide and should be submitted by email to kthornton@law.gwu.edu, with a pdf copy of the credit card receipt provided by ETDS.
Google to discover your paper. There is **no** requirement to register for a copyright.

4) The next step will prompt you to provide contact information where you can be reached. Please ensure you provide a permanent mailing and email address. Do not provide your GW email if you do no plan to use it anymore.

5) Next you will provide details about the title of your thesis, your degree, as well as your thesis adviser (there is no committee review for LLM theses). You will be prompted to provide text for a brief abstract, which will appear on the ETDS page as information for researchers in deciding whether or not to read your full paper. You may choose to simply use the same language from the abstract you provide in the preliminary pages of your thesis.

6) Next you will upload the document to ETDS in PDF format. Use the PDF converter function. FAQs about converting to PDF and much more are available at [http://www.etdadmin.com/cgibin/main/resources?siteld=55](http://www.etdadmin.com/cgibin/main/resources?siteld=55)

7) Next, you can choose to order bound copies of your thesis at your own expense.

8) Finally, you will click on “Submit.”

9) Once you have uploaded your document, the ETD administrator and Prof. Thornton will receive email notification and will review the document for consistency with the formatting guidelines provided in the law school’s thesis submission guidelines.

10) In the event that edits need to be made, either the ETD administrator or Prof. Thornton will ask you to make revisions in your original Word doc. After making the corrections to your Word doc, you must convert back to PDF and upload the new document. You will receive email notification when your thesis receives final approval and is uploaded to ETDS.
Attachment 4

ETD Approval Form
The George Washington University
Electronic Theses/Dissertations (ETD) Access / Approval Form

The information on this form should match exactly the record entered into the GW ProQuest ETD online system, (http://www.etdadmin.com) and should be submitted to your school or college’s graduate office at the same time you submit your thesis or dissertation online.

Student’s Full Name as on Thesis or Dissertation

GWID: __________________

ETD Submission ID#: ______________

Mailing Address:

________________________________________

________________________________________

________________________________________

Email: _________________________________ Phone: _________________________________

Degree (Official Abbreviation): ___________ Planned Graduation Date: ________________

School or College: ______________________________

Program: _________________________________

Campus: ❑ Foggy Bottom ❑ Virginia Campus ❑ Other: _________________________________

Type of Submission: ❑ Dissertation ❑ Thesis

Exact Thesis/Dissertation Title:

________________________________________

________________________________________

Name(s) of PDF Files(s) Submitted to ProQuest: Date of File: ________________

Thesis or Dissertation:

________________________________________

________________________________________

Supplements, if any:

1. ______________________________________

2. ______________________________________

3. ______________________________________

4. ______________________________________

Student and Thesis Advisor/Dissertation Director Certifications

Research Approvals
I hereby certify that I have obtained the required institutional approvals if my research involves human subjects, protected health information, animals, radiation or other hazardous materials, and the like (see http://www.gwumc.edu/research). In addition, this thesis or dissertation does not contain personally identifiable information that would compromise assurances of confidentiality to research participants.
Part B: Copyright (See Copyright and Patent Issues for more information.) Please select one of the following options:

1. [ ] I own the copyright in the thesis or dissertation as its author. I hereby grant to the George Washington University and its agents the non-exclusive, world-wide, royalty-free license to archive and make accessible, under the conditions specified below, my thesis or dissertation in whole or in part in all forms of media, now or hereafter known. I retain all other rights, title, and interest in my thesis or dissertation and may use all or part of my thesis or dissertation in future works (such as conference presentations or papers, articles, or books).

2. [ ] I have produced my thesis or dissertation for the U.S. Government as an officer or employee and therefore the thesis or dissertation is not subject to copyright (17 U.S.C. § 105).

Further, I hereby certify that, where warranted, I have obtained and attached hereto written permission statements from the owners of each third party copyrighted matter to be included in my thesis or dissertation, allowing distribution as specified below.

Part C: Release Statement (See Publication Issues for more information.)

In addition to the unrestricted display of the bibliographic information and the abstract, I agree that the above-mentioned document will be placed in the GW ProQuest ETD archive with the following status (choose one option from each of the options below). In all cases, the full text of all theses and dissertations will be available for unrestricted open access worldwide through the GW Libraries and Washington Research Library Consortium (WRLC) catalog either immediately or after the embargo period expires.

1. [ ] Unrestricted Open Access: Release the entire thesis or dissertation for free, open access worldwide.
   a. [ ] Immediate Release (Preferred option except in rare situations noted below), or
   b. [ ] Embargoed: Keep the thesis or dissertation from public access for a period of
      [ ] 6 months, [ ] 1 year, or [ ] 2 years while I pursue a commercial opportunity (such as a book
      contract or patent) or to meet research sponsor requirements. I understand that patent applications
      must comply with the GW Patent and Scholarly Works Policy.

   OR

2. [ ] Traditional Publishing: Release the entire work for purchase through ProQuest.
   a. [ ] Immediate Release (Option of choice except in rare situations noted below), or
   b. [ ] Embargoed: Keep the thesis or dissertation from public access for a period of
      [ ] 6 months, [ ] 1 year, or [ ] 2 years while I pursue a commercial opportunity (such as a book
      contract or patent) or to meet research sponsor requirements. I understand that patent applications
      must comply with the GW Patent and Scholarly Works Policy.

Thesis Advisor/Dissertation Director Verification of ETD:
I have reviewed the final electronic version of my thesis or dissertation to be submitted to GW ProQuest and have determined that it is an accurate representation of the document reviewed and approved by the Dissertation Research Committee or Thesis Advisor.

The undersigned agrees that this ETD Access / Approval Form updates any and all previous statements submitted heretofore.

Signed: ___________________________  Printed Name  ___________________________  Date ___________________________

Signed: ___________________________  Printed Name  ___________________________  Date ___________________________

Signed: ___________________________  Printed Name  ___________________________  Date ___________________________

Signed: ___________________________  Printed Name  ___________________________  Date ___________________________

Revision draft: vae/lw/kw/mg/kt  Wednesday, July 19, 2013  4818-7559-0419, v. 44818-
Attachment 5

Reimbursement Form
To: Fred Hahndorf  
Director of Administration & Finance

From: _____________________________________________  
_____GW Employee  
_____Non GW Employee

Subject: Request for Reimbursement

Date: ________________________________

It is requested that I be reimbursed for the following expense:

Amount: ____________________ If more than one receipt is attached, please itemize on a separate sheet of paper.

Activity: _____________________________________________
(luncheon, dinner, taxi fare, etc.)

Purpose: _____________________________________________

Attendees: ____________________________________________

Address to which check should be sent:

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

GWID Number: ____________________________________________

E-mail or Phone Number: ____________________________________________

Please attach original receipts and other supporting documents. Please submit other University forms - payment request, etc. - as appropriate.